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C SC 230
Computer Architecture and Assembly Language Programming

WOOKIE - 6811 Simulator User Guide

1. Introduction

The WOOKIE - 6811 simulator was written by Kalle Anderson, Jason Button, Paul
Clarke and Matt Enwald as a fourth year project in Computer Engineering at the
Milwaukee School of Engineering.  It is available as free-ware from MSOE at the site
http://www.msoe.edu/~barnicks/courses/cs280/cs280.htm and locally at
http://gulf.uvic.ca/~csc230.  WOOKIE runs under Windows 95 or Windows-NT.

WOOKIE emulates the full instruction set and addressing modes as well as the timer
subsection and external interrupts of the 6811.  It does not emulate the A-D conversion,
serial peripheral interface or serial communication interface subsections of the 6811.

2. Simulator Modes

The WOOKIE simulator has three modes of operation:

Brief Case (default) - Simulates 6811 expanded mode with a block of external RAM
mapped to 0xC000 - 0xFFFF.  The interrupt vectors are setup as pseudo-vectors.

Rug Warrior Startup - Runs HC11 in special bootstrap mode.  A block of external RAM
is mapped to the range 0x8000 - 0xFFFF.  Special bootstrap mode has certain ROM and
interrupt vector implications.  Ports B and C are disabled because they are used for the
address and data bus.

Rug Warrior Expanded - Runs HC11 in expanded mode.  A block of external RAM is
mapped to 0x8000 - 0xFFFF. Ports B and C are disabled because they are used for the
address and data bus.

3. Loading a 6811 Machine Language Program (.S19 File)
The simplest way to start the WOOKIE simulator and load a .S19 file, is to drag the .S19
file onto the WOOKIE simulator icon which is found in the C SC 230 folder on the
desktop.  A dialog box will appear in which you must select the HC11 mode (Fig. 1)
which will normally be Brief Case.  You must also specify the starting address for the
program (the initial value for the PC).  The value extracted from the .S19 file may not be
correct.  Note that this loads the .S19 object file, it does not start the simulation running
(see below).
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You can also load a 6811 machine language program by selecting Load .s19 in the File
menu and opening the desired file in the standard file dialog box.  This is not
recommended as artifacts of a prior program may remain in the simulator memory.  It is
better to start the simulation of a new program by quitting the simulator and launching the
new program as described above.

Fig. 1

The corresponding listing (.LST) file must be in the same directory as the chosen .S19
file.  The listing appears in the bottom half of the simulator’s split window as shown in
Fig. 2.

Fig. 2

Selecting the Close option in the File menu closes the listing, but the program remains in
simulator memory and can still be executed.  This is why artifacts may remain.
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4. Executing a Program

4.1 Continuous Execution
Click the traffic light button.  It will turn green and WOOKIE will be running in
continuous mode.  Click the button again to stop the simulation.  The light will turn red.
Other ways to start and stop the simulator are by pressing the G key or by selecting
Simulator Start/Stop in the Simulator menu.

4.2 Setting a Break Point
To set a break point so that the simulator will stop when the program counter reaches the
break point address, enter the value for the break point in the break point text box.  The
value should be in hex.  The simulator stops when it is time to fetch the instruction
identified by the Break Point address.  Break points are very helpful if the break point is
set inside interrupt handling code.

4.3 Stepping Through a Program
To step through the program code one instruction at a time, either click the walking man
button, press the space bar, or select Simulator Step in the Simulator menu.

The next instruction to be executed is highlighted in the LST view each time the simulator
stops i.e. an explicit stop, after each single step, or upon reaching the Break Point.

5. Terminating WOOKIE
Select Exit in the File menu or click the X box in the top right of the simulator window.

6. CPU Registers

6.1 Viewing the CPU Registers
To view the CPU registers, click on the MC68HC11 CPU button.  A pop-up window
containing the ACCA, ACCB, ACCD, IX, IY, SP, PC, and the CCR is displayed.  Notice
that all the other functions can still be performed from the tool bar or main interface while
this window is open.  The values for the registers are updated when the simulator is
stepped or stopped.  Left click and drag to move the window if it obscures other
information.

6.2 Modifying the CPU Registers
To change the value of a register, first click on its name so that it is highlighted.  Then
click on the Modify button in the MCU window.  Select the proper base and enter the new
value in the text box.  Notice that when a new base is selected, the value in the text box is
automatically converted to the new base.  Click OK when finished.
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7. Memory
The WOOKIE has an address range of $0000 to $FFFF.  There are various ways to view
and modify memory locations.

7.1 Viewing Memory
To view or set the contents of memory, click on the Memory button.  The dialog window
that is displayed will allow both view and modify operations.  If the Display Memory radio
button is selected, then the memory starting at the start address (base determined by the
numeric base) is displayed in the memory text box.  The number of bytes determines how
many bytes after the start address are displayed in the Memory text box.

7.2 Setting Memory
If the Set Memory radio button is selected in the Memory window, then the memory
starting at the start address is set to the first byte of memory in the Memory text box.  The
value in the Number of Bytes text box determines how many succeeding bytes after the
start address are also set to the first byte of the memory in the Memory text box.  NOTE
All bytes are set to the same value which is the first in the Memory text box.

7.3 Adding a Memory Watch
First, click on the Memory Watch button.  The Memory watch pop-up dialog will appear,
and can be left open while other commands are executed, such as step or run.  To add a
memory watch, click the Add button in the Memory Watch window.  Add the name of
your variable and the address in hex.  The variable name, address and contents will be
displayed in the Memory Watch window upon clicking OK.

To change the value of any variable in the memory watch, click on the name of the
variable so that its name is highlighted, and click on the Modify button.  The following
window will display the current value of the variable in its text box in the base
corresponding to its Memory Watch base.  Select the proper base and enter the new value.
Notice that the number in the text box will automatically be converted when a new base is
selected.  Click OK to change the value of the variable to the contents of the text box.

The only time the values of Memory Watch variables are updated is when the simulator is
stopped or stepped.  To update the values while the simulator is running, click on the
Update button.

To delete a memory watch from the display, click on the name of the variable and then
click the Delete button.  To toggle the base of the value of all the variables among hex,
decimal and binary, click the Base button.

7.4 Adding All the FCB and RMB Variables to the Memory Watch
To automatically add all the FCB and RMB labels in the LST file as Memory Watch
variables, Click select Add Rmb watches in the Tools menu.  The Memory Watch window
must be open to perform this function.
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8. Registers
To view the values of the registers at memory addresses $1000 to $103F click the
Registers button.  The Register Watch window has the same functionality as the Memory
Watch window.  The functions are the same as the Memory Watch window, except the
Add and Delete buttons are not available.  All the registers are already displayed with their
standard names.  If other addresses are to be observed, use the Memory Watch window.

9. Ports
The 6811 WOOKIE has separate display facilities for ports A through E.

9.1 Viewing the State of a Port
To view a port, click on the corresponding Port button. The selected Port window will
appear with eight LEDs and its hex value.  A bright red LED indicates a high state on the
pin, and a dark LED represents a low state on the pin. The Port window is a pop-up
dialog window, so other functions can be executed while the window remains open.  The
state will automatically be updated during both the single step and continuous run modes
of simulation.

A Port can be made active high or active low by clicking on the appropriate button.
Active high means a LED lights when the corresponding bit is a 1.  Active low means a
LED lights when the corresponding bit is a 0.

9.2 Toggling the State of a Pin
To toggle the state of a pin, click on its LED and the value will automatically change.
This can be done whether the simulator is running or stopped.

10. Interrupts
The WOOKIE simulates the IRQ, XIRQ and RESET external interrupts.  Buttons are
provided so the user can assert these interrupts.  WOOKIE also simulates the interrupts
associated with the timer subsection of the 6811.  As WOOKIE does not simulate the A-D
conversion, serial peripheral interface or serial communication interface subsections of the
6811, it does not support the associated interrupts.

In Brief Case mode, WOOKIE sets the interrupt vectors as shown in Table 1 (end of
document). These default settings can be overridden by the program.

As noted above, the Break Point can be very helpful in debugging an interrupt handler.
The usual technique is to set the Break Point to the starting address of the interrupt
handling routine so that the simulation will stop when the interrupt occurs.

11. The 7 Segment Display
The function of the WOOKIE simulator is misnamed as it is actually a simulation of a
multi-segment display.  It can display letters and digits specified in ASCII code.  The
display is a simulation of a device driven by Ports B and C.  The four character positions
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are indexed as 0, 1, 2, 3 from right to left.  The following short segment of code displays
the letter W in the rightmost position of the display as shown in Fig. 3.  Note the setting of
the Port C data direction register DDRC and the setting of STRB (bit 0 of the PIOC
register) to 0.

REGBAS EQU $1000
PORTB EQU $04
PORTC EQU $03
DDRC EQU $07
PIOC EQU $02

LDX #REGBAS
LDAA #$FF
STAA DDRC,X /set Port C to output
LDAA PIOC,X
ANDA #$FE
STAA PIOC,X /set INVB to 0
LDAA #$0
STAA PORTC,x /select rightmost posiiton
LDAA #$57
STAA PORTB,X /display letter w
WAI

Fig. 3

12. Pin Scope
The Pin Scope Tool can be used to watch the output produced at one pin of a selected
port.  Open the tool by clicking the Pin Scope button.  Then click on the Attach button
and specify the desired port and pin (pin 0 is the rightmost pin in a port).  You can attach
the scope to a pin while the program is running and can change the connection while the
program is running.  Closing the Pin Scope window releases the current connection.  Pin
Scope displays characteristics of the waveform observed on the pin.

For example, the following program toggles pin 0 in Port B at a fixed frequency.
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REGBAS EQU $1000
PORTB EQU $04

DELAY EQU 255

LDX #REGBAS
LDAA #0

LOOP STAA PORTB,X / set all pins of Port A to 0
LDY #DELAY

WAIT DEY
BNE WAIT / delay by counting
EORA #1 / flip bit 0 in ACCA
JMP LOOP
END

Attaching the Pin Scope to pin 0 of Port B produces the display in Fig. 4.

Fig. 4

13. Comments and Corrections
This document is intended for use by students in C SC 230 and for others who might use
the WOOKIE simulator for educational work at UVic.  Comments and corrections should
be sent to mmiller@csr.uvic.ca.
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Source Int. Vector Brief Case Default
XIRQ $FFF4-$FFF5 $00F1
IRQ $FFF2-$FFF3 $00EE
RTI $FFF0-$FFF1 $00EB
IC1 $FFEE-$FFEF $00E8
IC2 $FFEC-$FFED $00E5
IC3 $FFEA-$FFEB $00E2
OC1
OC2
OC3
OC4
OC5

$FFE8-$FFE9
$FFE6-$FFE7
$FFE4-$FFE5
$FFE2-$FFE3
$FFE0-$FFE1

$00DF
$00DC
$00D9
$00D6
$00D3

TOI
PAOV

PAI
SPIE
SCI

$FFDE-$FFDF
$FFDC-$FFDD
$FFDA-$FFDB
$FFD8-$FFD9
$FFD6-$FFD7

$00D0
$00CD
$00CA

---
---

Table 1: Brief Case Interrupt Vector Defaults


